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Abstract 
 
Today, knowing the spatial distribution of flood risk using GIS (Geographic Information Systems)-based MCDM (Multi-Criteria 

Decision Making) approaches has been a topic addressed by many researchers. In this context, the current study focuses on the spatial 

distribution of flood risk using the N-AHP (Neutrosophic Analytical Hierarchy Process)-based GIS approach. The Melet Basin 

(Türkiye) is a case study for the suggested methodology. Four decision-makers used linguistic phrases to compare and assess the flood 

criteria during the method's application phase. The opinions of the decision makers were combined with the N-AHP, and the criteria 

were weighted. The results determined that precipitation, distance from the river, drainage density, land use, and slope were the most 

important factors affecting the flood and contributed approximately 74%. Apart from this, it has been observed that 10% of the basin 

is in the high and very high flood risk classes, and these risky areas overlap with the flood points of past periods. The proposed 

approach and findings are anticipated to have theoretical and practical implications. 
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Nötrosofik Analitik Hiyerarşi Süreci (N-AHS) ve CBS Teknikleri Kullanılarak Melet 
Havzası'nda (Türkiye) Taşkın Risk Değerlendirmesi 
 
Özet 
 
Günümüzde CBS (Coğrafi Bilgi Sistemleri) tabanlı ÇKKV (Çok Kriterli Karar Verme) yaklaşımları kullanılarak taşkın riskinin 

mekansal dağılımının bilinmesi birçok araştırmacının ele aldığı bir konu olmuştur. Bu bağlamda mevcut çalışma, N-AHS (Nötrosofik 

Analitik Hiyerarşi Süreci) tabanlı CBS yaklaşımını kullanarak taşkın riskinin mekansal dağılımına odaklanmaktadır. Önerilen 

yaklaşım Melet Havzası'nda (Türkiye) bir örnek olay olarak incelenmiştir. Yöntemin uygulama aşamasında dört karar verici taşkın 

kriterlerini dilsel terimler kullanarak birbirleriyle karşılaştırmıştır. Karar vericilerin görüşleri N-AHS ile birleştirilerek kriterler 

ağırlıklandırılmıştır. Sonuçlar, yağış, nehirden uzaklık, drenaj yoğunluğu, arazi kullanımı ve eğimin taşkını etkileyen en önemli 

faktörler olduğunu ve bu faktörlerin yaklaşık %74 oranında taşkına neden olduğu belirlenmiştir. Bunun dışında havzanın %10'unun 

yüksek ve çok yüksek taşkın riski sınıflarında yer aldığı ve bu riskli alanların geçmiş dönemlerin taşkın noktalarıyla örtüştüğü 

görülmüştür. Önerilen yaklaşım ve bulguların teorik ve pratik çıkarımlara sahip olması beklenmektedir. 
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1. Introduction 
 
Flooding is a disaster often associated with natural and anthropogenic conditions, causing flooding of land or rivers 

(Mishra & Sinha, 2020). Flood events are considered one of the most dangerous and widespread natural disasters due to 

their devastating effects on many people and the natural environment worldwide (Foudi et al., 2015; Li et al., 2016; 

Mudashiru et al., 2022b). Because highly complex and dynamic processes play a role in floods' formation, preventing 

their occurrence is almost impossible (Pappenberger et al., 2006; Wu et al., 2022). Therefore, to analyse floods effectively, 

it is necessary to know the degree of impact of flood factors based on the characteristics of the basins (Mudashiru et al., 

2022a). Flood risk assessment has become one of the hottest topics in natural sciences and technology worldwide. 
Numerous techniques have been put forth and used recently for mapping flood risk. In particular, GIS and remote sensing 

methods were focused on to evaluate the flood risk from a topographic, meteorological and socioeconomic perspective 

(Cai et al., 2019; Özşahin, 2022). The methods above have allowed for the regional assessment of flood hazard zones, 

often along the axis of different variables influencing the development of this natural disaster (Lappas & Kallioras, 2019; 

Liu et al., 2019; Wu et al., 2022). Several factors influence and increase flood risk, including hydrology, population, poor 

land use, inadequate drainage systems, and geoenvironmental features (Mudashiru et al., 2022a; Zhang et al, 2018).  
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While the mentioned factors usually consist of qualitative factors with different layers and complex structures, 

determining the impact of these factors plays a crucial role in flood assessment (Wu et al., 2022). Many studies have 

applied GIS-based MCDA (Multi-Criteria Decision Analysis) for flood risk assessment in this context (Jun et al., 2013; 

Chen et al., 2015; Arabameri et al., 2019; Hammami et al., 2019; Toosi et al., 2019; Kanani-Sadat et al., 2019; Mishra & 

Sinha, 2020; Aydın & Birincioğlu, 2022; Taş & Yanık, 2022). The most commonly used MCDM technique was AHP 

(Analytical Hierarchy Process). AHP is an MCDM technique that allows determining the priority and weight values of 

the factors that are effective in decision-making in a problem. AHP offers a practical approach to quantify the parameters 

affecting the flood, especially in flood risk mapping. However, AHP does not consider the inconsistency or bias of 

decision-makers in pairwise comparison. This may lead to doubts and uncertainties in the assessment of flood risk (Wu 

et al., 2022). Against this limitation of the AHP technique, many researchers have suggested the use of Zadeh (1965)'s 

fuzzy set (FS) theory with AHP (Abdel Basset et al., 2018a; Vafadarnikjoo & Scherz, 2021; Yucesan & Gul, 2021). To 

capture uncertainty, several flood assessment studies have concentrated on the fuzzy AHP (F-AHP), an extension of the 

AHP based on fuzzy sets (FS). The fuzzy set, on the other hand, is limited to the membership function. It has failed to 

capture the ambiguity in the real world because it ignores non-membership and uncertainty (Abdel-Basset et al., 2018a; 

2018b). Because of this, Smarandache (1995) developed the notion of neutrosophic sets (NS), in which information is 

represented by three membership degrees that are ambiguous and inconsistent. Membership degrees in NS consist of three 

independent membership functions called truth-membership TA(x), falsity-membership FA(x), and uncertainty-

membership IA(x) functions (Stanujkić et al., 2021). Later, Wang et al. (2010) proposed a different version of NS, the 

single valued neutrosophic set (SVNS). Recently, many researchers have focused on NSs, SVNSs and their extensions to 

solve complex MCDM problems that are inherently uncertain and inconsistent. In the literature, many studies (Ahmad & 

Simonovic, 2011; Yang et al., 2013; Lai et al., 2015; Hategekimana et al., 2018; Lyu et al., 2020; Tella & Balogun, 2020; 

Ekmekçioğlu et al., 2021; Vilasan & Kapse, 2021; Cai et al., 2021; Souissi et al., 2022; Arca & Yalçın, 2023 e.g.) evaluate 

flood risk with fuzzy sets. However, the integrated use of NS and AHP has not been found in the flood risk assessment 

literature. However, some studies have addressed the extension of AHP simultaneously with Neutrosophic Set (NS) 

theories, which can improve decision-making in uncertain environments (Abdel-Basset et al., 2018a; 2018b; 

Vafadarnikjoo et al., 2018; Stanujkić et al., 2021; Vafadarnikjoo et al., 2021; Vafadarnikjoo & Scherz, 2021). It is stated 

that integrating neutrosophic logic with AHP eliminates the need for consistent data to be obtained by experts (Kaur & 

Garg, 2022). This will allow more objective results to be brought in flood risk assessment. Due to the advantages of N-

AHP and the literature gaps, it aims to use the approach mentioned in the current study in an integrated manner with GIS. 

For this purpose, the Melet River Basin, one of the important basins of Turkey, was chosen as the study area. Many flood 

disasters have occurred, especially in the lower part of the basin. With changes in land use, the risk of possible floods in 

the basin continues (Şenol, 2019b). Therefore, the proposed approach was tested in this basin. Testing which factors are 

more effective in these floods with the proposed approach can provide various insights to explain flood behaviour. In 

addition, fuzzing the GIS-AHP approach, frequently used in flood studies, will give a more objective and theoretically 

based contribution to the subject area. 
 
2. Description of the Study Area 
 
The Melet River Basin is located on the eastern border of the Central Black Sea Section of the Black Sea Region. The 

Melet River is located approximately between latitudes 40ᵒ 20' and 40ᵒ  59' N and longitudes 37ᵒ 36' and 38ᵒ 02' E. Bird 

flight to the Black Sea originates from the vicinity of Karagöl Mountain (3107 m), which is 70 km away, passing through 

Ordu province and pouring into the Black Sea. The Melet River Basin features a dendritic drainage network with a width 

of approximately 70 km in north-south and 30 km in east-west directions (Figure 1).  

The eastern borders of the Melet River Basin from the Black Sea coastal belt; Bahşişkıranı (423 m), Fındıklı (457 m), 

Düzyatak (1059 m), Gürgen (1271 m), Aydoğan (1971 m), Kayabaşı (1756 m), Gerişüstü (1708 m) and Körgöz (2030 m) 

hills form, Its eastern borders are Dikilisırik (2212 m), Çakıl (2108 m), Karagöl (3107 m), Yıldız (1836 m), Summer 

(2012 m), Koru (2123 m) and Kabadüz (889 m) hills. Dozens of tributaries, such as Sap, Kanlı and Baldıran, are connected 

to the Melet River. The basin is a profoundly cleaved valley through the Melet River and its tributaries (Figure 1).  

The Melet River Basin completed its geological development from the Cretaceous to the Quaternary. Upper 

Cretaceous aged limestones and Tertiary volcanic are found on the Gerişüstü, Körgöz and Dikilisırık Hills, which form 

the peaks belt in the south of the basin. Moving south from the summits section, there are Upper Cretaceous aged volcanic 

around Mesudiye, Upper Cretaceous aged granitoid in Topçam, Upper Cretaceous aged volcanic in Kabadüz, and 

Quaternary alluviums in the Black Sea coastal belt (Keskin, 2011; Sümengen, 2013). Most of the Melet River Basin 

comprises volcanic rocks and a small portion of metamorphic rocks (Figure 3). 
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Figure 1: Location map of the Melet River Basin 

 

The Black Sea Region, where the Melet basin is located, has the highest rainfall in Turkey. For this reason, frequent flood 

events occur in the Black Sea coastal belt rivers. Various flood events have occurred in the Melet basin in the past years. 

In the Melet Basin, nearly 20 flood events occurred from 1944 to 2014 (Hatipoğlu, 2017). With the opening of the river 

beds in the basin for settlement, any loss of life and property may occur in the floods (Şenol, 2019a). This is among the 

most important problems of Turkey and the basin waiting to be solved. 

 
3. Methodology 
 
The GIS multi-criteria decision analysis (MCDA) structure is used in the study's methodology. In this approach, flood 

risk analysis of the Melet River Basin in the Black Sea Region of Turkey was carried out using GIS and NS-AHP. The 

principles of NS and the application steps of the methodological approach are presented in the following sections. 

 
3.1 Geospatial Data Sources and Preparation 
 
Various parameters need to be determined to evaluate flood susceptibility and create a flood model. Since there is no 

fixed model in the literature, the use of parameters may vary according to different spatial scales (Tehrany et al., 2014). 

Eleven factors were used in this study to create appropriate thematic maps. Characteristics of the Melet Basin and previous 

research (Ghosh & Kar, 2018; Souissi et al., 2022; Tella & Balogun, 2020; Penki et al., 2022; Negese et al., 2022; 

Mudashiru et al., 2022b) were used to determine the following flood susceptibility factors. The methodological flow of 

this study is shown in Figure 2. Table 3 presents the data used in the research and their characteristics. 



Flood risk assessment using Neutrosophic Analytical Hierarchy Process (N-AHP) and GIS techniques in the Melet Basin (Türkiye) 

 

298 
 

 
Figure 2: Flow chart 

 
Table 1: Geospatial data and sources 

 
Data Year Source Extracted data 

ASTER GDEM 2020 
USGS (United States Geological 
Survey) Earth Explorer 

Elevation, slope, TWI, distance to stream, 
drainage density, SPI 

LANDSAT-8 OLI 2019 USGS Earth Explorer LULC (Land Use and Land Cover) 

Digital Soil Map of the District 2018 Map General Command Soil map 
AnnualyRainfall Data  1970-2022 National Weather Station Rainfall map 

Geology 2020 

MTA (English- General 

Directorate of Mineral Research 

and Exploration) 

Lithology map 

Flood inventory points 1960-2020 

AFAD (English- Disaster and 

Emergency Management 
Presidency) and Literature 

 

 
While determining the boundaries of the research area, the river branches joining the Melet River were followed. The 

watershed lines were drawn on 27 maps following the water division lines on the 1/25.000 scale topography maps. All 

the parameters that create the flood risk have been calculated by considering this limit, and the risky areas have been 

determined by subjecting the weighted overlap analysis. In creating thematic maps of the research area, firstly, the 

elevation model of the basin was downloaded using the Digital Elevation Map (DEM) data, the United States Geological 

Survey (USGS) database, which constitutes the study area. This downloaded data was arranged in the following stages to 

create a primary data source for the TWI, SPI, slope analysis and elevation parameters. DEM data are up-to-date data of 

2022 for satellite bands n40_e37 and n40_e38 via ASTER GDEM. 

The DEM data of the research area was cut in accordance with the field boundaries. Before this stage, since the data 

covering the study area consisted of two separate bands, the collection process was carried out under a single band. Arc 

Toolbox Data Management Tools Raster Dataset Mosaic to New Raster operations on ArcGIS 10.8 created a single band 

out of the data, which was then extracted using the Extract by Mask method and clipped according to the field. The cut 

data is manually divided into five classes with Spatial Analyst Tools→Reclass→Reclassify operation. 

Slope analysis used in flood risk analysis was created by applying Arc Toolbox→Spatial Analyst 

Tools→Surface→Slope analysis using DEM data as baseline data. The slope parameter created was divided into six 

classes again according to the slope classes in the literature, and a weight value was assigned to each of them. 

The data related to the amount of precipitation, another parameter, was created in an Excel environment of 52 years 

of precipitation data on a monthly basis, taking the averages in parallel with the altitude. Here, Schreiber's 54 mm 

precipitation increase in every 100 m was applied to the research area, and then the precipitation data were evaluated in 

5 different classes and weight coefficients were assigned. The precipitation data set, arranged according to Schreiber, was 

adapted according to the formula below; 

 

Ph= Po+(54*h) (1) 
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The distance to the river’s parameter used in the flood risk analysis is processed with the Analysis Tools → Proximity → 

Multiple Ring Buffer analysis via ArcGIS over the previously created river lines about the distance to the river lines, and 

the value increases as the buffer moves away from the rivers at the closest distance with the highest weight value. It was 

formed by giving the values where the state of the Here, again, the classification was made and the weighting process 

was carried out so that the weight values were suitable for the classes. 

In the study of bedrock (lithology) parameters, manual digitization of MTA 1/100,000 scaled G39-40 and H39-40 

sheets on ArcGIS was primarily performed. In the next step, the main rock groups were assigned weight coefficients by 

adding a separate field as sedimentary, volcanic and metamorphic rocks within themselves. The map was converted to 

raster format by Arc Toolbox → Conversion Tools → To Raster → Polygon to Raster operation of the leading rock 

groups forming the basin according to the assigned weight coefficients. 

The drainage density parameter was carried out with the Arc Toolbox→Spatial Analyst→Density→Line Density 

process to determine how long the stream density per unit area after the digitization of the streams from the 1st index 

forming the basin up to the highest level. After this stage, the densities were reclassified, and the polygon data was created. 

A new field has been added to the completed new polygon data, and weight coefficients have been entered. The conversion 

process from polygon to raster data format was performed according to this new data set. 

Data with the .shp extension produced by the General Command of Mapping was used to create the factor map for 

the soil. The soil groups in the data set were separated according to the Large Soil Groups, the field was added, and the 

weight coefficient definition was made for the new field added. This newly created data set was converted from polygon 

data to raster format according to weight coefficients. 

The land cover and management in the research area were prepared in 2020 using the data of the European 

Environment Agency CORINE (Coordination of Information on the Environment). By adding a new field to the data set, 

weighting coefficients were given and converted to raster format. 

Topographic Wetness Index and Stream Power Index calculations were calculated from the Flow Accumulation data 

created using the research area's DEM data as raw data. While making the estimates, operations were carried out on the 

DEM data used before and Slope analysis over ArcGIS Map Algebra. 

 

𝑇𝑊𝐼 = ln (
𝐴𝑠
tan 𝛽

) 

 

     (2) 

 

𝑆𝑃𝐼 = ln(𝐴𝑠. tan 𝛽)      (3) 

 

NDVI analysis was performed to determine biological activities on behalf of plant index values (Tucker, 1979). In 

NDVI analysis, values vary between -1 and +1. Here, negative values reveal lands devoid of vegetation; values between 

0.001 and 0.33 indicate maquis, bushes or neglected areas, while values between 0.33 and 0.66 indicate forested lands. 

Values above 0.66 indicate the presence of dense forest and a lively surface. LANDSAT-8 OLI data was used when 

conducting the NDVI analysis. Here, the data of bands 4 and 5 are processed. Vegetation status was tried to be determined 

by applying the data of bands belonging to near-infrared and red colours 2016_01_T1_B4 and 2016_01_T1_B5 bands 

with Map Algebra on Raster Calculator in ArcGIS environment to the following formula; 

 

𝑁𝐷𝑉𝐼 =
(𝑁𝐼𝑅 − 𝑅𝑒𝑑)

(𝑁𝐼𝑅 + 𝑅𝑒𝑑)
      (4) 

 
3.2 Preliminaries: Neutrosophic Set Theory 
 
The neutrosophic theory was developed by Florentin Smarandache in 1998. On the other hand, SVNS (Single-Valued 

Neutrosophic Sets), considered a subclass of the neutrosophic set, is, suggested by Wang et al. (2010). This section 

provides definitions for NS and SVNS. 

Definition 1 Neutrosophic set (NS) (Smarandache, 1999; Vafadarnikjoo, 2020). Let X be a point-space (object-space) 

in A where the generic elements are represented by x. The truth-membership function TA(x), the uncertainty-membership 

function IA(x), and the false-membership function FA(x) define a neutrosophic set in X, A. The functions TA(x), IA(x), 

and FA(x) are true standard or nonstandard subsets of ]0−, 1+ [. Namely, TA(x)⟶]0− , 1+ [, IA(x)⟶]0− , 1+ [and 

FA(x)⟶]0− , 1+ [. Therefore, there is no care on the sum of TA(x), IA(x) and FA(x) i.e., 0− ≤ 𝑇𝐴(𝑥) + 𝐼𝐴(𝑥) + 𝐹𝐴(𝑥) ≤
3+. 

Definition 2 Single-valued neutrosophic set (SVNS) (Wang et al., 2010). Let X be a space of points (objects) with 

generic elements denoted by x in X. A SVNS A in X is characterized by the truth-membership function TA(x), the 

uncertainty-membership function IA(x) and the false-membership function FA(x). So a SVNS A can be denoted by 𝐴 =
{〈𝑥, 𝑇𝐴(𝑥), 𝐼𝐴(𝑥), 𝐹𝐴(𝑥)〉𝑥 ∈ 𝑋}, where TA(x), IA(x), FA(x)∈ [0, 1] for every x point in X. Therefore, the sum of TA(x), IA(x) 

and FA(x)satisfies the condition 0 ≤ 𝑇𝐴(𝑥) + 𝐼𝐴(𝑥) + 𝐹𝐴(𝑥) ≤ 3. 
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Definition 3 Single-valued trapezoidal neutrosophic number (SVTNN) (Deli & Subas, 2014; Vafadarnikjoo et al., 2021; 

Vafadarnikjoo & Scherz, 2021). An SVTNN 𝑎̃ = <(𝑎1, 𝑏1, 𝑐1, 𝑑1);𝓌𝑎̃, 𝑢𝑎̃, 𝑦𝑎̃ >, 𝑎1, 𝑏1, 𝑐1, 𝑑1  ∈  𝑅, 𝑎1 ≤ 𝑏1 ≤ 𝑐1 ≤ 𝑑1, 

and𝓌𝑎̃, 𝑢𝑎̃, 𝑦𝑎̃ ∈  [0,1] is a particular single-valued neutrosophic number (SVNN) whose 𝑇ã(x), 𝐼ã(x) and 𝐹ã(x) are 

presented as the following Eqs. (5) to (7) respectively: 

𝑇ã(𝑥) =

{
  
 

  
 
(𝑥 − 𝑎1)𝓌ã

(𝑏1 − 𝑎1)
, 𝑎1  ≤  𝑥 < 𝑏1,

𝓌ã,                   𝑏1 ≤ 𝑥 ≤ 𝑐1,
(𝑑1 − 𝑥)𝓌ã

(𝑑1−𝑐1)
, 𝑐1 < 𝑥 ≤ 𝑑1,

0,                      𝑜𝑡ℎ𝑒𝑟𝑤𝑖𝑠𝑒,

   (5) 

 

𝐼ã(𝑥) =

{
  
 

  
 
(𝑏1 − 𝑥 + 𝑢ã(𝑥 − 𝑎1))

(𝑏1 − 𝑎1)
, 𝑎1 ≤  𝑥 < 𝑏1,

𝑢ã,                                      𝑏1 ≤ 𝑥 ≤ 𝑐1,
(𝑥 − 𝑐1 + 𝑢ã(𝑑1 − 𝑥))

(𝑑1 − 𝑐1)
, 𝑐1 < 𝑥 ≤ 𝑑1,

1,                                           𝑜𝑡ℎ𝑒𝑟𝑤𝑖𝑠𝑒,

   (6) 

 

𝐹ã(𝑥) =

{
  
 

  
 
(𝑏1 − 𝑥 + 𝑦ã(𝑥 − 𝑎1))

(𝑏1 − 𝑎1)
, 𝑎1 ≤  𝑥 < 𝑏1,

𝑦ã,                                      𝑏1 ≤ 𝑥 ≤ 𝑐1,
(𝑥 − 𝑐1 + 𝑦ã(𝑑1 − 𝑥))

(𝑑1 − 𝑐1)
, 𝑐1 < 𝑥 ≤ 𝑑1,

1,                                           𝑜𝑡ℎ𝑒𝑟𝑤𝑖𝑠𝑒,

   (7) 

 

Definition 4 (Vafadarnikjoo et al., 2021). Let 𝑎̃ = 〈(𝑎1, 𝑏1, 𝑐1, 𝑑1); 𝑤𝑎̃, 𝑢𝑎̃, 𝑦𝑎̃〉 𝑎𝑛𝑑 𝑏̃ = 〈(𝑎2, 𝑏2, 𝑐2, 𝑑2); 𝑤𝑏̃ , 𝑢𝑏̃ , 𝑦𝑏̃〉 
be two SVTNNs and 𝜆 ≠ 0 and positive then. 

𝑎̃ + 𝑏̃ = 〈(𝑎1 + 𝑎2, 𝑏1 + 𝑏2, 𝑐1 + 𝑐2, 𝑑1 + 𝑑2); 𝑤𝑎̃ +𝑤𝑏̃ − 𝑤𝑎̃𝑤𝑏̃ , 𝑢𝑎̃𝑢𝑏̃ , 𝑦𝑎̃𝑦𝑏̃〉 

𝑎̃𝑏̃ = 〈(𝑎1𝑎2, 𝑏1𝑏2, 𝑐1𝑐2, 𝑑1𝑑2); 𝑤𝑎̃𝑤𝑏̃ , 𝑢𝑎̃ + 𝑢𝑏̃ − 𝑢𝑎̃𝑢𝑏̃ , 𝑦𝑎̃ + 𝑦𝑏̃ − 𝑦𝑎̃𝑦𝑏̃〉 

𝜆𝑎̃ = 〈(𝜆𝑎1, 𝜆𝑏1, 𝜆𝑐1, 𝜆𝑑1); 1 − (1 − 𝑤𝑎̃)
𝜆 , 𝑢𝑎̃

𝜆 , 𝑦𝑎̃
𝜆〉 

𝑎̃𝜆 = 〈(𝑎1
𝜆, 𝑏1

𝜆, 𝑐1
𝜆 , 𝑑1

Γ); 𝑤𝑎̃
𝜆1 − (1 − 𝑢𝑎̃)

𝜆, 1 − (1 − 𝑦𝑎̃)
𝜆〉 

  (8) 

 

Definition 5 The TNWAA operator (Ye, 2017; Vafadarnikjoo et al., 2021; Vafadarnikjoo & Scherz, 2021). Let 𝑎̃𝑗 =<

(𝑎𝑗 , 𝑏𝑗 , 𝑐𝑗 , 𝑑𝑗);𝓌𝑎̃, 𝑢𝑎̃, 𝑦𝑎̃ > (𝑗 = 1,2, … , 𝑛) be a set of SVTNNs, then a trapezoidal neutrosophic weighted arithmetic 

averaging (TNWAA) operator is computed on the based-on Eq. (9): 

𝑇𝑁𝑊𝐴𝐴(𝑎̃1, 𝑎̃2, . . , 𝑎̃𝑛) =∑𝑝𝑗𝑎̃𝑗

𝑛

𝑗=1

 

=< (∑𝑝𝑗𝑎𝑗

𝑛

𝑗=1

,∑𝑝𝑗𝑏𝑗

𝑛

𝑗=1

,∑𝑝𝑗𝑐𝑗

𝑛

𝑗=1

,∑𝑝𝑗𝑑𝑗

𝑛

𝑗=1

) ; 1 

∏(1−𝓌𝑎̃𝑗
) 𝑝𝑗 ,∏𝑢𝑎̃𝑗

𝑝𝑗

𝑛

𝑗=1

,∏𝑦𝑎̃𝑗
𝑝𝑗

𝑛

𝑗=1

𝑛

𝑗=1

>, 

  (9) 

 

where 𝑝𝑗is theweight of𝑎̃𝑗(𝑗 = 1,2, . . . , 𝑛)while𝑝𝑗 > 0,and∑ 𝑝𝑗 = 1.
𝑛
𝑗=1  

 

Definition 6 Scorefunction of a SVTNN (Ye, 2017; Vafadarnikjoo et al., 2021; Vafadarnikjoo & Scherz 2021). Given 

𝑎̃ = < (𝑎, 𝑏, 𝑐, 𝑑);𝓌𝑎̃, 𝑢𝑎̃ , 𝑦𝑎̃ > and 𝑎, 𝑏, 𝑐, 𝑑 > 0. Then, the score function of 𝑎̃ can be calculated in accordance with the 

following Eq. (10): 

𝑆(𝑎̃) =
1

12
(𝑎 + 𝑏 + 𝑐 + 𝑑)(2 +𝓌𝑎̃ − 𝑢𝑎̃ − 𝑦𝑎̃), 𝑆(𝑎̃) ∈ [0,1]. (10) 
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Definition 7 In order to compare two SVTNNs (Vafadarnikjoo and Scherz 2021). 𝑎̃ = < (𝑎1, 𝑏1, 𝑐1, 𝑑1);𝓌𝑎̃, 𝑢𝑎̃, 𝑦𝑎̃ >, and 

 𝑏̃ = < (𝑎2, 𝑏2, 𝑐2, 𝑑2);𝓌𝑏̃ , 𝑢𝑏̃ , 𝑦𝑏̃ >where𝑎1, 𝑏1, 𝑐1, 𝑑1,𝑎2, 𝑏2, 𝑐2, 𝑑2 > 0,then according to Eq. (7), the score functions 

will be computed, and if 𝑆(𝑎̃) > 𝑆(𝑏̃),then 𝑎̃ > 𝑏;̃ if 𝑆(𝑎̃) = 𝑆(𝑏̃), then 𝑎̃ = 𝑏̃. 
 

3.3 The N‑AHP procedure 
 

The steps of the proposed N-AHP method to analyze the weights of the factors affecting the flood risk in the Melet River 

Basin and to provide a ranking are as follows (Abdel-Basset et al., 2018a; Vafadarnikjoo et al., 2021; Vafadarnikjoo & 

Scherz, 2021). 

Step 1: The problem, which consists of goals and criteria, is structured hierarchically. 

Step 2: Pairwise comparisons are made for the criteria. DMs use a linguistic expression on a scale of 1-9 (Saaty, 1980) 

to determine the importance of each item. 

 
Table 2: The importance rating scale (Saaty, 2005). 

 

Numerical scala Verbal scale Abbreviations 

1 Equal importance EI 

2 Weak importance WI 

3 Moderate importance MI 

4 Moderate plus importance MPI 

5 Strong importance SI 

6 Strong plus importance SPI 

7 Very strong importance VSI 

8 Very very strong importance VVSI 

9 Extreme importance EXI 

 

Based on the experts' answers, pairwise comparison matrices (n × n) are arranged using Eq. (11). 

𝐴̃𝑘 = [𝑎𝑖𝑗𝑘] =

[
 
 
 
 
 
 

1 𝑎12𝑘 … 𝑎1𝑛𝑘

1/𝑎12𝑘 1 … 𝑎2𝑛𝑘

⋮ ⋮ ⋱ ⋮

1/𝑎1𝑛𝑘 1/𝑎2𝑛𝑘 … 1 ]
 
 
 
 
 
 

 (11) 

 

Step 3: The consistency ratio (CR) is calculated; the consistency ratio must be less than 0.1 for all pairwise comparisons. 

𝐶𝑅 =  
((𝜆𝑚𝑎𝑥 − 𝑛)/(𝑛 − 1)

𝑅𝐼
 (12) 

 

Step 4: Values in the initial pairwise comparison matrices are replaced with SVTNNs using the scale shown in Table 2. 

 
Table 3: Neutrosophic rating scale (Vafadarnikjoo & Scherz, 2021) 

 

 

Numerical scale SVTNNs Score function 

1/9 〈(0.11, 0.11, 0.11, 0.11); 1, 0, 0〉 0.11 

1/8 〈(0.11, 0.11, 0.13, 0.14); 1, 0, 0〉 0.12 

1/7 〈(0.11, 0.13, 0.14, 0.17); 1, 0, 0〉 0.14 

1/6 〈(0.13, 0.14, 0.17, 0.2); 1, 0, 0〉 0.16 

1/5 〈(0.14, 0.17, 0.2, 0.25); 1, 0, 0〉 0.19 

1/4 〈(0.17, 0.20, 0.25, 0.33); 1, 0, 0〉 0.24 

1/3 〈(0.14, 0.17, 0.33, 0.50); 1, 0, 0〉 0.29 

1/2 〈(0.20, 0.25, 0.5, 1); 1, 0, 0〉 0.49 

1/9 〈(0.11, 0.11, 0.11, 0.11); 1, 0, 0〉 0.11 

1 〈(1, 1, 1, 1); 0.5, 0.5, 0.5〉 0.5 

2 〈(1, 2, 4, 5); 0.4, 0.65, 0.6〉 1.15 

3 〈(2, 3, 6, 7); 0.3, 0.75, 0.7〉 1.28 

4 〈(3, 4, 5, 6); 0.6, 0.35, 0.4〉 2.78 

5 〈(4, 5, 6, 7); 0.8, 0.15, 0.2〉 4.49 

6 〈(5, 6, 7, 8); 0.7, 0.25, 0.3〉 4.66 

7 〈(6, 7, 8, 9); 0.9, 0.1, 0.1〉 6.75 

8 〈(7, 8, 9, 9); 0.85, 0.1, 0.15〉 7.15 

9 〈(9, 9, 9, 9); 1, 0, 0〉 9 

 



Flood risk assessment using Neutrosophic Analytical Hierarchy Process (N-AHP) and GIS techniques in the Melet Basin (Türkiye) 

 

302 
 

Step 5: Opinions of DMs are aggregated in matrices created with SVTNNs. To aggregate the views of more than one 

DM, the TNWAA operator is used, as shown in Eq. (9). 

 

Step 6: Neutrosophic synthetic values are calculated. This step is calculated according to the following equation. 

𝑆𝑖 =∑𝑛𝑖𝑗 × [∑∑𝑛𝑖𝑗

𝑛

𝑗=1

𝑛

𝑖=1

]

−1
𝑛

𝑗=1

, 𝑖 = 1, . . . , 𝑛, (13) 

 

where n is the number of elements and ηij is the (i, j)th element of the clustered pairwise comparison matrix.  

 

Step 7: In the final stage, the final weights of importance are determined. The weights are calculated based on eq. (14) 

below, and the equation in Definition (7) is used to compare the weights. 

𝑊𝑖 =
𝑆𝑖

∑ 𝑆𝑖
𝑛
𝑖=1

, 𝑖 = 1, . . . , 𝑛. (14) 

 
3.4. Reclassification of Parameters and Flood Susceptibility Mapping 
 

Each of the eleven thematic layers prepared is divided into various classes. Subunits of the parameters were rated as 

having importance in influencing flood formation. In the rating process, the threshold values in the common literature 

and the general geographical characteristics of the research area were considered. The thematic layers are divided into 

five categories (excluding lithology and NDVI) (1 = very low impact, and 5 = very high impact). 

The ArcGIS program converted Each parametric layer to 30 × 30 m raster format. The ratings given to each parameter 

class were used by the "Reclass" module to generate the layers. Drawing the final flood risk susceptibility map of the 

Melet Basin was made possible by combining the various layers using the "Map Calculator" module. The following 

formula generated the iterative flood risk index (FHI) computation: 

 

𝐹𝐻𝐼 =∑𝑊𝑖𝐹𝑖

𝑛

𝑖=1

 
(15) 

 

where Wi corresponds to the weight of each factor, Fi is the rating factor, and n is the number of parameters. 

Finally, the resulting flood risk map was reclassified into five groups; very high, high, medium, low and very low 

using Natural Break Jenks (Arabameri et al., 2019; Mudashiru et al., 2022b). Natural Breaks (Jenks) method is a data 

classification technique used in GIS and spatial statistics. It is used to group similar values in a data set into a set of classes 

or clusters based on their statistical properties (Lu et al., 2021). 

 
4. Results and Discussion 
 
In the study, thematic maps of 11 parameters were first produced and reclassified. The class range values of the thematic 

maps produced and the tables and texts showing the share of the said value range in the basin's total area are given below. 

The elevation of the research area is divided into five categories according to its impact on flood hazards: Very high (2250 

m and above), high (1500–2250 m), medium (750–1500 m), low (250–750 m) and very low (250 m and below). Each 

class covers approximately 3.14%, 41.46%, 38.57%, 13.38% and 3.45% of the total catchment area, respectively (Table 

4; Figure 3). Cultivated lands constitute 32.18% of the basin's land use, while structuring is 0.46%, and wetland, bare and 

forest areas are 0.51%, 32.54%, and 34.31%, respectively (Table 4; Figure 7).  Denser vegetation can reduce an area's 

vulnerability to flooding. The NDVI layer is divided into low (-1) and high (1). While 17.33% of the basin is low-class 

land, 82.67% is high-class land (Table 4; Figure 7). It is divided into five classes according to the effect on soil type risk: 

very high (sandy clay loam), high (clay), medium (sandy loam), low (clay loam) and very low (loam). Each class covers 

approximately 0.20%, 3.29%, 0.05%, 38.22% and 58.24% of the total catchment area, respectively (Table 4; Figure 8). 

Detailed findings for other parameters are included in Table 4. 
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Table 4: Selected parameters of flood susceptibility of Melet Basin 
 

Criteria Classes 
Reclas 

sclass 

Area 

(km2) 

Rate 

(%) 
Criteria Classes 

Reclas 

sclass 

Area 

(km2) 

Rate 

(%) 

Elevation 

< 250 5 68 3,45 

Topographic 

wetness index 
(TWI) 

2.48–5.91 1 1123 56,92 

250-750 4 264 13,38 5.91–8.09 2 336 17,03 

750-1500 3 761 38,57 8.09–10.18 3 116 5,88 

1500-2250 2 818 41,46 10.18–12.63 4 77 3,90 

> 2250 1 62 3,14 12.63–22.77 5 321 16,27 

Slope 

< 6 5 205 10,39 

Distance to 

stream 

> 5 5 10 0,51 

6–12 4 385 19,51 5.10 4 10 0,51 

12-18 3 430 21,79 10.25 3 29 1,47 

18-36 2 866 43,89 25-50 2 48 2,43 

> 36 1 87 4,41 < 50 1 1876 95,08 

Lithology 

Sediment 4 16 0,81 

Land 

use/landcover 

Water body 5 10 0,51 

Volcanic 3 1338 67,82 Urban area 4 9 0,46 

Metamorphic 2 619 31,37 Bareland 3 642 32,54 

Drainage 

density 

> 6 5 158 8,01 
Cultivated 

area 
2 635 32,18 

4.5 – 6 4 470 23,82 Forest area 1 677 34,31 

3 – 4.5 3 698 35,38 
NDVI 

− 1 2 342 17,33 

1.5 – 3 2 434 22,00 1 4 1631 82,67 

< 1.5 1 213 10,80 

Soil 

Sandy 

clayloam 
5 4 0,20 

Average 

annual rainfall 

<750 1 303 15,36 Clay 4 65 3,29 

750-1050 2 483 24,48 Sandy Loam 3 1 0,05 

1050-1350 3 876 44,40 Clay Loam 2 754 38,22 

1350-1650 4 293 14,85 Loam 1 1149 58,24 

1650 + 5 18 0,91      

Stream power 

index (SPI) 

− 10 to − 8 1 1 0,05      

− 7 to − 3 2 87 4,41      

− 2 to − 0.9 3 261 13,23      

− 0.8 to – 2 4 1584 80,28      

3–8 5 40 2,03      
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Figure 3: Tematic layers: elevation and slope 
 

 
 

Figure 4: Tematic layers: lithology and drainage density 
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Figure 5: Tematic layers rainfall and SPI 
 

 
 

Figure 6. Tematic layers: TWI and distance from streams 
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Figure 7: Tematic layers: Land use and NDVI 
 

 
 

Figure 8: Tematic layers: soil 

 
4.1. N-AHP- GIS Approach 
 
Eleven factors were employed in this work to map flood hazards. The reclassification method splits each parameter into 

relevant subclasses. Then, the application steps of the neutrosophic fuzzy AHP were followed, and the weight values of 

the parameters were calculated. The normalized weight values were analyzed in the GIS tool to estimate the Flood Hazard 

Index using Equation (14). The main stages of the application are presented in detail below. 
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First, the NF-AHP technique was applied to obtain the weights of the parameters effective in floods. In the study, a DM 

group of four was determined to evaluate 11 parameters by pairwise comparisons. The DMs selection process was based 

on the participant's knowledge and expertise. DMs' short profiles are presented in Table 5. Each DM was assigned a 

weight of importance ρ = (0.25, 0.35, 0.30, 0.10)T according to their knowledge and experience. These weight values 

were then used in the aggregation calculations of the responses with the TNWAA operator. 

 
Table 5: Weights of the DMs 

 

DMs Expertise Weights 

DM1 Physical Geography, Geomorphology 0.25 

DM2 Natural disasters 0.35 

DM3 Natural Disasters, Risk Analysis 0.30 

DM4 Geomorphology 0.10 

 

Four DMs rated factors using the rating scale (1-9) given in Table 2. First, pairwise comparison matrices were created 

based on the data obtained as a result of the evaluations (Table 6). 
 

Table 6: Initial decision matrix 
 

DM1 C1 C2 C3 C4 C5 C6 C7 C8 C9 C10 C11 

C1-Elevation 1 1/5 1/3 1 1/7 4 1/5 1/6 1/4 1 1/5 
C2- Slope  1 1/3 4 5 1 1/4 1/3 1/2 3 1/4 

C3- Lithology   1 1 1/3 1 1/5 1/5 1 1 1/4 

C4- Drainage density    1 1/3 1/4 1/2 1/6 1/4 3 1/5 
C5- Average annual rainfall     1 1 1 1/4 2 3 1/3 

C6- SPI      1 1 1 3 5 1 

C7- TWI       1 1 5 6 4 
C8- Distance to stream        1 4 6 1/2 

C9- LULC         1 6 1/4 

C10- NDVI          1 1/5 
C11- Soil           1 

DM2 C1 C2 C3 C4 C5 C6 C7 C8 C9 C10 C11 

C1-Elevation 1 1/7 1/2 0 1/2 1/5 1/5 1/7 1/5 1/5 5 

C2- Slope  1 1/3 4 5 1 1/4 1/3 1/2 3 1/4 
C3- Lithology   1 1 1/3 1 1/5 1/5 1 1 1/4 

C4- Drainage density    1 1/3 1/4 1/2 1/6 1/4 3 1/5 

C5- Average annual rainfall     1 1 1 1/4 2 3 1/3 
C6- SPI      1 1 1 3 5 1 

C7- TWI       1 1 5 6 4 

C8- Distance to stream        1 4 6 1/2 
C9- LULC         1 6 1/4 

C10- NDVI          1 1/5 

C11- Soil           1 

DM3 C1 C2 C3 C4 C5 C6 C7 C8 C9 C10 C11 

C1-Elevation 1 1/7 1/2 0 1/2 1/5 1/5 1/7 1/5 1/5 5 

C2- Slope  1 1/3 4 5 1 1/4 1/3 1/2 3 1/4 

C3- Lithology   1 1 1/3 1 1/5 1/5 1 1 1/4 
C4- Drainage density    1 1/3 1/4 1/2 1/6 1/4 3 1/5 

C5- Average annual rainfall     1 1 1 1/4 2 3 1/3 

C6- SPI      1 1 1 3 5 1 
C7- TWI       1 1 5 6 4 

C8- Distance to stream        1 4 6 1/2 

C9- LULC         1 6 1/4 
C10- NDVI          1 1/5 

C11- Soil           1 

DM4 C1 C2 C3 C4 C5 C6 C7 C8 C9 C10 C11 

C1-Elevation 1 1/7 1/2 0 1/2 1/5 1/5 1/7 1/5 1/5 5 
C2- Slope  1 1/3 4 5 1 1/4 1/3 1/2 3 1/4 

C3- Lithology   1 1 1/3 1 1/5 1/5 1 1 1/4 

C4- Drainage density    1 1/3 1/4 1/2 1/6 1/4 3 1/5 
C5- Average annual rainfall     1 1 1 1/4 2 3 1/3 

C6- SPI      1 1 1 3 5 1 

C7- TWI       1 1 5 6 4 
C8- Distance to stream        1 4 6 1/2 

C9- LULC         1 6 1/4 

C10- NDVI          1 1/5 
C11- Soil           1 

 
The CR values of the first pairwise comparison matrices were calculated using equation (11), and the CR values for 

all matrices were below 10%. 
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Then, the values in the first pairwise comparison matrices obtained on a scale of 1-9 were converted to SVTNNs in Table 

3. In the next step, the TNWAA operator is used, as shown in equation (8), to aggregate the views of more than one DM 

in the matrices created with SVTNN. In Table 7, the combined decision matrix of all factors is given.  
 

Table 7: Aggregated decision matrix 
 

C1 C2 C3 

C1 〈(1.00, 1.00, 1.00, 1.00); 0.50, 0.50, 0.50〉 〈(1.17, 1.59, 2.20, 2.62); 1.00, 0.00, 0.00〉 〈(0.63, 0.91, 1.82, 2.35); 1.00, 0.00, 0.00〉 

C2 〈(3.17, 3.78, 4.41, 3.65); 1.00, 0.00, 0.00〉 〈(1.00, 1.00, 1.00, 1.00); 0.50, 0.50, 0.50〉 〈(3.96, 4.22, 4.98, 5.25); 1.00, 0.00, 0.00〉 

C3 〈(1.09, 1.84, 3.68, 5.88); 1.00, 0.00, 0.00〉 〈(0.57, 0.68, 1.02, 1.16); 1.00, 0.00, 0.00〉 〈(1.00, 1.00, 1.00, 1.00); 0.50, 0.50, 0.50〉 

C4 〈(3.55, 4.25, 4.95, 5.65); 0.75, 0.23, 0.25〉 〈(2.09, 2.50, 2.90, 3.31); 1.00, 0.00, 0.00〉 〈(1.95, 2.21, 2.47, 2.74); 1.00, 0.00, 0.00〉 

C5 〈(3.15, 4.15, 5.50, 6.50); 0.73, 0.24, 0.34〉 〈(2.00, 2.75, 3.85, 4.60); 0.53, 0.46, 0.47〉 〈(4.60, 5.60, 6.60, 7.60); 0.82, 0.16, 0.18〉 

C6 〈(1.97, 2.58, 3.70, 4.32); 1.00, 0.00, 0.00〉 〈(0.51, 0.63, 0.93, 1.21); 1.00, 0.00, 0.00〉 〈(0.91, 1.52, 2.99, 3.62); 1.00, 0.00, 0.00〉 

C7 〈(2.35, 3.00, 4.25, 4.90); 0.60, 0.37, 0.00〉 〈(1.51, 1.93, 2.66, 3.28); 1.00, 0.00, 0.00〉 〈(2.35, 3.25, 4.50, 5.40); 0.60, 0.36, 0.40〉 

C8 〈(4.35, 5.35, 6.60, 7.60); 0.76, 0.23, 0.22〉 〈(2.74, 3.40, 4.55, 5.21); 1.00, 0.00, 0.00〉 〈(2.45, 3.20, 4.75, 5.50); 0.58, 0.39, 0.42〉 

C9 〈(3.05, 3.80, 4.75, 5.50); 0.71, 0.24, 0.29〉 〈(1.69, 2.10, 2.70, 3.11); 1.00, 0.00, 0.00〉 〈(1.50, 2.20, 3.35, 4.05); 0.49, 0.51, 0.51〉 

C10 〈(0.61, 0.88, 1.66, 1.96); 1.00, 0.00, 0.00〉 〈(0.94, 1.19, 1.94, 2.19); 1.00, 0.00, 0.00〉 〈(0.87, 1.14, 1.49, 1.87); 1.00, 0.00, 0.00〉 

C11 〈(1.60, 2.26, 3.22, 3.93); 1.00, 0.00, 0.00〉 〈(0.78, 1.10, 2.01, 2.34); 1.00, 0.00, 0.00〉 〈(0.61, 0.74, 1.14, 1.43); 1.00, 0.00, 0.00〉 

C4 C5 C6 

C1 〈(0.39, 0.41, 0.42, 0.45); 1.00, 0.00, 0.00〉 〈(0.16, 0.19, 0.30, 0.50); 1.00, 0.00, 0.00〉 〈(1.38, 1.80, 2.25, 2.71); 1.00, 0.00, 0.00〉 

C2 〈(2.41, 2.76, 3.13, 3.49); 1.00, 0.00, 0.00〉 〈(0.38, 0.41, 0.52, 0.72); 1.00, 0.00, 0.00〉 〈(1.67, 2.28, 3.25, 3.90); 1.00, 0.00, 0.00〉 

C3 〈(1.83, 2.18, 2.54, 2.89); 1.00, 0.00, 0.00〉 〈(0.14, 0.16, 0.19, 0.24); 1.00, 0.00, 0.00〉 〈(1.51, 1.93, 2.46, 3.08); 1.00, 0.00, 0.00〉 

C4 〈(1.00, 1.00, 1.00, 1.00); 0.50, 0.50, 0.50〉 〈(0.79, 1.54, 3.08, 3.88); 1.00, 0.00, 0.00〉 〈(3.80, 4.80, 6.30, 7.30); 0.72, 0.27, 0.28〉 

C5 〈(0.65, 0.94, 1.88, 2.50); 1.00, 0.00, 0.00〉 〈(1.00, 1.00, 1.00, 1.00); 0.50, 0.50, 0.50〉 〈(4.40, 5.40, 6.40, 7.40); 0.76, 0.18, 0.24〉 

C6 〈(0.14, 0.17, 0.23, 0.32); 1.00, 0.00, 0.00〉 〈(0.14, 0.16, 0.19, 0.23); 1.00, 0.00, 0.00〉 〈(1.00, 1.00, 1.00, 1.00); 0.50, 0.50, 0.50〉 

C7 〈(0.39, 0.41, 0.42, 0.45); 1.00, 0.00, 0.00〉 〈(0.15, 0.18, 0.24, 0.33); 1.00, 0.00, 0.00〉 〈(1.35, 2.01, 3.97, 4.64); 1.00, 0.00, 0.00〉 

C8 〈(0.48, 0.50, 0.52, 0.55); 1.00, 0.00, 0.00〉 〈(0.19, 0.23, 0.43, 0.81); 1.00, 0.00, 0.00〉 〈(2.80, 3.80, 6.00, 7.00); 0.58, 0.39, 0.42〉 

C9 〈(1.55, 2.45, 4.80, 5.70); 0.36, 0.69, 0.64〉 〈(0.53, 0.90, 1.66, 2.08); 1.00, 0.00, 0.00〉 〈(2.76, 3.42, 4.09, 4.77); 1.00, 0.00, 0.00〉 

C10 〈(0.18, 0.22, 0.34, 0.56); 1.00, 0.00, 0.00〉 〈(0.16, 0.19, 0.23, 0.30); 1.00, 0.00, 0.00〉 〈(0.60, 0.72, 1.05, 1.20); 1.00, 0.00, 0.00〉 

C11 〈(0.40, 0.43, 0.50, 0.61); 1.00, 0.00, 0.00〉 〈(0.14, 0.17, 0.25, 0.34); 1.00, 0.00, 0.00〉 〈(1.19, 1.60, 2.60, 3.01); 1.00, 0.00, 0.00〉 

C7 C8 C9 

C1 〈(0.44, 0.46, 0.52, 0.59); 1.00, 0.00, 0.00〉 〈(0.14, 0.16, 0.24, 0.39); 1.00, 0.00, 0.00〉 〈(0.36, 0.38, 0.41, 0.46); 1.00, 0.00, 0.00〉 

C2 〈(0.91, 1.52, 2.99, 3.63); 1.00, 0.00, 0.00〉 〈(2.18, 2.55, 2.94, 3.35); 1.00, 0.00, 0.00〉 〈(2.41, 2.77, 3.14, 3.53); 1.00, 0.00, 0.00〉 

C3 〈(0.26, 0.29, 0.40, 0.61); 1.00, 0.00, 0.00〉 〈(0.36, 0.63, 1.20, 0.79); 1.00, 0.00, 0.00〉 〈(0.43, 0.46, 0.59, 0.83); 1.00, 0.00, 0.00〉 

C4 〈(3.80, 4.50, 5.20, 5.90); 0.79, 0.19, 0.21〉 〈(2.80, 3.40, 4.00, 4.60); 0.71, 0.24, 0.29〉 〈(0.25, 0.28, 0.46, 0.73); 1.00, 0.00, 0.00〉 

C5 〈(3.30, 4.30, 5.80, 6.80); 0.65, 0.30, 0.35〉 〈(1.75, 2.75, 4.50, 5.50); 0.54, 0.45, 0.46〉 〈(1.52, 2.09, 3.33, 4.05); 1.00, 0.00, 0.00〉 

C6 〈(1.49, 1.86, 2.31, 2.78); 1.00, 0.00, 0.00〉 〈(0.14, 0.17, 0.28, 0.40); 1.00, 0.00, 0.00〉 〈(1.14, 1.51, 1.88, 2.26); 1.00, 0.00, 0.00〉 

C7 〈(1.00, 1.00, 1.00, 1.00); 0.50, 0.50, 0.50〉 〈(0.44, 0.81, 1.60, 2.05); 1.00, 0.00, 0.00〉 〈(0.79, 1.16, 2.26, 2.68); 1.00, 0.00, 0.00〉 

C8 〈(1.57, 2.24, 4.08, 4.90); 1.00, 0.00, 0.00〉 〈(1.00, 1.00, 1.00, 1.00); 0.50, 0.50, 0.50〉 〈(1.25, 1.85, 3.30, 3.90); 0.42, 0.61, 0.58〉 

C9 〈(2.15, 2.81, 4.02, 4.73); 1.00, 0.00, 0.00〉 〈(0.51, 0.53, 0.66, 0.88); 1.00, 0.00, 0.00〉 〈(1.00, 1.00, 1.00, 1.00); 0.50, 0.50, 0.50〉 

C10 〈(0.22, 0.25, 0.36, 0.48); 1.00, 0.00, 0.00〉 〈(0.17, 0.21, 0.36, 0.62); 1.00, 0.00, 0.00〉 〈(0.17, 0.20, 0.31, 0.52); 1.00, 0.00, 0.00〉 

C11 〈(0.49, 0.51, 0.58, 0.66); 1.00, 0.00, 0.00〉 〈(0.14, 0.17, 0.19, 0.25); 1.00, 0.00, 0.00〉 〈(0.17, 0.21, 0.32, 0.54); 1.00, 0.00, 0.00〉 

C10 C11  

C1 〈(2.84, 3.59, 4.38, 5.18); 1.00, 0.00, 0.00〉 〈(0.82, 1.19, 2.32, 2.82); 1.00, 0.00, 0.00〉  

C2 〈(3.59, 3.59, 3.63, 3.68); 1.00, 0.00, 0.00〉 〈(3.24, 3.85, 4.50, 5.15); 1.00, 0.00, 0.00〉  

C3 〈(1.74, 2.50, 4.06, 4.83); 1.00, 0.00, 0.00〉 〈(1.41, 2.02, 2.98, 3.60); 1.00, 0.00, 0.00〉  

C4 〈(2.30, 3.30, 4.65, 5.65); 0.54, 0.43, 0.46〉 〈(2.30, 3.00, 4.30, 5.00); 0.60, 0.37, 0.40〉  

C5 〈(3.35, 4.35, 5.35, 6.35); 0.69, 0.26, 0.31〉 〈(3.30, 4.30, 6.00, 7.00); 0.69, 0.26, 0.31〉  

C6 〈(2.11, 2.72, 3.33, 3.95); 1.00, 0.00, 0.00〉 〈(2.41, 2.77, 3.17, 3.58); 1.00, 0.00, 0.00〉  

C7 〈(2.65, 3.55, 5.75, 6.65); 0.45, 0.55, 0.55〉 〈(1.85, 2.45, 3.75, 4.35); 0.47, 0.53, 0.53〉  

C8 〈(2.35, 3.35, 5.65, 6.65); 0.42, 0.57, 0.58〉 〈(4.40, 5.40, 6.40, 7.40); 0.81, 0.17, 0.19〉  

C9 〈(2.90, 3.90, 5.25, 6.25); 0.67, 0.30, 0.33〉 〈(2.65, 3.65, 5.00, 6.00); 0.64, 0.32, 0.36〉  

C10 〈(1.00, 1.00, 1.00, 1.00); 0.50, 0.50, 0.50〉 〈(0.45, 0.83, 1.61, 2.08); 1.00, 0.00, 0.00〉  

C11 〈(1.52, 2.19, 3.63, 4.45); 1.00, 0.00, 0.00〉 〈(1.00, 1.00, 1.00, 1.00); 0.50, 0.50, 0.50〉  

 
Then, the neutrosophic synthetic values were calculated by applying Equation (12) to the combined matrix obtained. 

In the final stage, the factors' final weights were estimated using Equation (13) (Table 8). 
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Table 8: The weights of the criteria 
 

No Criteria SVTNN weights Crisp Normalised % 

C1 Elevation 〈(0.013, 0.027, 0.094, 0.212); 1, 0, 0〉 0,086 0,051 5,1 

C2 Slope 〈(0.033, 0.066, 0.204, 0.414); 1, 0, 0〉 0,179 0,106 10,6 

C3 Lithology 〈(0.014, 0.032, 0.119, 0.276); 1, 0, 0〉 0,110 0,065 6,5 

C4 Drainage density 〈(0.033, 0.071, 0.232, 0.508); 1, 0, 0〉 0,211 0,125 12,5 

C5 Average annual rainfall 〈(0.039, 0.087, 0.296, 0.625); 1, 0, 0〉 0,262 0,155 15,5 

C6 Stream power index (SPI) 〈(0.016, 0.035, 0.118, 0.263); 1, 0, 0〉 0,108 0,064 6,4 

C7 Topographic wetness index (TWI) 〈(0.020, 0.046, 0.179, 0.396); 1, 0, 0〉 0,160 0,095 9,5 

C8 Distance to stream 〈(0.032, 0.070, 0.255, 0.560); 1, 0, 0〉 0,229 0,136 13,6 

C9 Landuse/landcover 〈(0.027, 0.062, 0.220, 0.489); 1, 0, 0〉 0,199 0,118 11,8 

C10 NDVI 〈(0.007, 0.016, 0.061, 0.142); 1, 0, 0〉 0,056 0,034 3,4 

C11 Soil 〈(0.011, 0.024, 0.091, 0.206); 1, 0, 0〉 0,083 0,049 4,9 

 
Ultimately, all parameters were transformed into a raster format by utilising a raster calculator in ArcGIS to superimpose 

each raster layer depending on the weights acquired using the NF-AHP technique and setting the spatial resolution of 

each raster layer to a cell size of 30 m × 30 m. This technique produced an integrated database with five flood susceptibility 

classes. These: 

 

– Very low flood risk class representing 4.2% (83 km2) of the watershed; 

– Low flood class covering 43.34% (855 km2) of the basin and covering a large area throughout the basin; 

– Middle flood class covering 41.87% (826 km2) of the basin; 

– High flood class covering 9.88% (195 km2) of the basin; 

– It is a very high flood class, corresponding to 0.71% of the basin. 
 

Table 9: Flood susceptibility, area coverage and percentage 
 

Risk Status Class Area (km2) Ratio (%) 

Very Low  1 83 4,21 

Low 2 855 43,34 

Medium 3 826 41,87 

High 4 195 9,88 

Very High 5 14 0,71 

Sum 1973 100 

 
According to the spatial findings of the study, the very low flood class is mainly distributed in areas far from the main 

drainage networks. Along with the low, the medium flood class corresponds to 85% of the basin. The regions 

corresponding to the high to very high flood class tend to be concentrated primarily in the city centre of Ordu, which is 

located at the sea level of the basin, and in the upper reaches of the basin, where both the elevation is high, and the leading 

drainage network is dense. The findings showed that 10% of the basin has a high flood potential. In Hatipoğlu (2017)'s 

study, which deals with the lower and middle course of the basin, they determined a high flood class of 1%. The first 

reason for this proportional difference in both studies is the inclusion of the basin in the upper course of the current 

research; secondly, in Hatipoğlu (2017)'s analysis, the parameters were individually weighted to be completed on the 

face. In the present study, it can be explained that weighting the parameters with NF-AHP provides more objective results. 

Through factor grading, precipitation, distance from the river, drainage density, LULC and slope were found to be the 

most important factors affecting flooding, contributing approximately 74%. In comparison, combining the other five 

layers contributed 26% to flood risk. These findings are partially consistent with those obtained by similar studies (Morea 

& Samanta, 2020; Tella & Balogun, 2020; Hagos et al., 2022; Penki et al., 2022) in the literature. For example, Hagos et 

al. (2022) found that slope, drainage density, distance from the river and precipitation are the most important parameters 

in flood formation in their Ethiopian Awash River basin study. Apart from these, the LULC factor has been an important 

flood parameter of the basin in the current study. This finding is consistent with the results of Nsangou et al. (2022), 

Vaddiraju and Talari (2022), and Ghosh and Kar (2018) about LULC forming an important flood parameter. Among these 

five factors that most affect flood events in the region, LULC has undergone a significant change in recent years. In 

particular, the flat areas in the lower part of the basin have been a rapid urban expansion area. According to Şenol (2019a), 

the settlement areas, which covered an area of 2.3 km2 in 1990, increased to 38 km2 2018 throughout the basin. This 

change caused a high level of soil impermeability (Das, 2019) and increased the flood risk in residential areas. 
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Figure 9: Flood risk rates chart 

 
4.2. Validation 
 

The final stage of flood susceptibility studies is the making of verification maps. In the current study, a verification map 

was produced by combining the last flood risk sensitivity map with the locations of the floods that occurred in the past. 

When the map is examined, it is seen that the floods experienced in the past periods correspond to the high-risk and risky 

regions in the current research. It is seen that it is concentrated in the centre of Ordu province, which is located at the 

point where the basin spills into the sea. These results prove the validity of the NF-AHP approach proposed in the study 

of flood risk mapping. 

 
 

Figure 10: Flood inventory and flood susceptibility map of Melet Basin 

4%

43%

42%

10%

1%

Flood risk rates

Very low

Low

Medium

High

Very high



Murat Fıçıcı / Volume:10 ∙ Issue:2 ∙ July 2024 

311 
 

5. Conclusion 
 

As in the world, floods cause significant loss of life and property every year in Turkey. For this reason, developed flood 

simulations and risk assessment models can be used as a strategic planning tool to identify possible flood areas and reduce 

losses. In this context, the current study aimed to evaluate the flood sensitivity of the Melet River Basin with GIS-based 

MCDM. In weighting flood parameters, the N-AHP technique was used as an alternative to traditional AHP. It is stated 

that this technique can be a useful tool in minimizing the uncertainty and ambiguity encountered in the expert evaluation 

and in obtaining more objective results. 

The elevation, precipitation, slope, aspect, TWI, SPI, drainage density, lithology, soil, precipitation, and distance from 

streams were among the inputs used by the N-AHP model to map flood vulnerability. The analysis revealed that the main 

variables influencing flooding in the basin were slope, LULC, drainage density, distance from the river, and precipitation. 

In addition, risky flood areas of the basin were verified against data from previous floods. It has been observed that the 

suggested NF-AHP technique can be a valuable tool for determining flood risk regions and creating maps of flood 

susceptibility. The study's maps can be used as a reference by planners, developers, and local and federal governments to 

help them prepare for and prevent flooding. It is expected that the results may aid different stakeholders in precisely 

identifying regions that are vulnerable to flooding and putting in place suitable flood control measures in such locations. 

Finally, the current study's results can be used as a reference for managing flood vulnerability in the Melet Basin. National 

and local governments can learn about high-risk areas to contain floods and improve flood prevention systems. 
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